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Introduction 

One of the features that was added in Version 4 of GeoGebra is a secondary graphics 
view that can be dynamically linked to the primary graphics view.  In this paper, we 
explore some of the opportunities provided by this second graphics window.  
Specifically, we explain how to create a zoom utility that shows students global and local 
views of a graph simultaneously, and a parametric equations tool that shows the graph of 
a parametrically defined curve together with the graphs of the component functions.  We 
also give suggestions for worksheets that allow students to explore the relationship 
between Cartesian and polar graphs of the same function, and between the unit circle and 
the sine function. 

GeoGebra is free software, distributed under the GNU General Public License.  It can be 
run locally on multiple platforms without an internet connection, but one of its strengths 
is that you can create web applets and web pages that your students can use without 
having to download and install GeoGebra on their own computers.  In addition to the 
GeoGebra computer software, there is now a GeoGebra app available for iOS and 
Android mobile devices.  The mobile version of GeoGebra is currently not as rich as the 
computer version.  In particular, the GeoGebra use described in this paper is not currently 
available through the mobile app.  To get started with GeoGebra, visit the GeoGebra web 
site, at http://www.geogebra.org. 

Zoom Utility

In Figure 1, we see two views of the graph of a function.  In the panel on the left, we see 
a large scale version of the graph.  The highlighted rectangle in that view is expanded to 
fill the entire panel on the right.  Having the two different perspectives side-by-side helps 
a student understand how features in a small region of a graph relate to the function as a 
whole.  This juxtaposition may also serve as a reminder for the student that the graph on 
the left is not the whole picture either – there may well be other features that lie outside 
of the viewing window. 
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Figure 1:  Zoom Utility 

You can investigate this tool on GeoGebraTube, at 

http://www.geogebratube.org/student/msOd3EhOt. 

Creating this zoom utility requires just a few easy steps. 

 Open a new GeoGebra worksheet, and use the point tool  to create points A

and B, which will be the opposite corners of the secondary viewing window. 

 Use the perpendicular line tool  to create lines through A perpendicular to 

both coordinate axes, and lines through B perpendicular to both coordinate axes. 

 Use the polygon tool  to create the rectangle whose vertices are the 

intersection points of the lines.   
 In the Algebra view, click the radio buttons to hide the perpendicular lines and 

points C and D.  Right click on the edges of the rectangle, and deselect “Show 
Label.”

 Right click on the rectangle, and open the Object Properties.  In the Style tab, 
check the “Inverse Filling” box.  This will make the rectangle white and shade the 
rest of the graphics window.  Use the Color tab to adjust the color properties, and 
then close the Object Properties dialog box. 
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Figure 2:  Adjusting the style of the rectangle 

 In the View menu tab, choose Graphics 2 to open the second graphics view.  Drag 
the dividing line between the two graph windows to adjust the way in which they 
share the available space.   

 Right click in the Graphics 2 pane and choose Graphics in order to adjust the 
settings for this view.

 Under the Basic tab, set the values of xMin, xMax, yMin, and yMax, using the 
commands  x A  and  y A  for the x- and y-coordinates of the point A, and 

similarly  x B  and  y B  for the x- and y-coordinates of the point B.  If A is the 
upper left corner and B the lower right corner of the rectangle, then your 
preferences should be set as in Figure 3. 

Figure 3:  Setting the dimensions for the Graphics 2 window 

 In the xAxis and yAxis tabs, click the “Stick to Edge” box so that the x- and y-
axes are displayed in this graphics view, regardless of whether the origin is visible 
in that view.  Then close the Graphics dialog box. 
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 As you move points A and B, you should see the scale on the axes in the second 
window change. 

 All that’s missing now is a function to explore.  Enter a function, like 
   2/32 1 1    f x x x x , in the input bar.  Its graph will be drawn in 

whichever graphics view is currently active.   
 Right click on the function (either in the graphics view or the algebra view) and 

open its Object Properties.  In the Advanced tab, make sure that Graphics and 
Graphics 2 are both checked, so that the graph will be drawn in both views. 

Figure 4:  Ensuring the graph is drawn in both windows 

 Drag points A and B so that the rectangle is positioned over the portion of the 
graph you wish to explore. 

 If you like, close the Algebra view.  You may also choose to add an input box to 
make changing the function definition easier for students. 

Parametric Curves

One of the reasons that students struggle when first learning about parameterized curves 
is that they are used to thinking in terms of graphs defined by single equations.  So for 
example, the function  sin 2x t  represents a graph for which the independent variable t
is on the horizontal axis, and the dependent variable x is on the vertical axis.  (Actually, 
calling the dependent variable “x” can be a stretch for some students.)  Making the leap to 
a situation where the pair of equations  sin 2x t  and 2 cosy t  represent a single 
curve, and the variable t has no representative axis, can be difficult.  By making use of 
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the two graphics views in GeoGebra, we can show students the familiar graphs of 
 sin 2x t  and 2 cosy t  in one view, while making connections to the parametrically 

defined curve in the other other view. 

Figure 5:  Two views of parametric equations 

You can investigate this tool on GeoGebraTube, at  

http://www.geogebratube.org/student/mMznTGiXP. 

As with the zoom utility above, creating this tool is straightforward. 

 Open a new GeoGebra worksheet, and define two functions of the parameter t,
such as    sin 2f t t  and   2 cosg t t .  (Unfortunately, GeoGebra will not 
permit the use of x or y as function names.) 

 Open the object properties for these functions and change their graphs to 
contrasting colors. 
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 Plot a point A on the horizontal axis.  Open the object properties for this point, 
and change its caption to t.  Also change the “Show Label” option to Caption. 

Figure 6:  Showing the caption for the parameter 

 Use the input bar to create the points      ,B x A f x A  and 

     ,C x A g x A  on the graphs of f  and g.  When you drag the point labeled 

t along the horizontal axis, the points on the graphs of  f  and g will move 
accordingly. 

 In the Options menu tab, choose Point Capturing, and select “Off,” so that the 
point t moves smoothly along the axis. 

 In the object properties for points B and C, change the captions to  ,t x  and  ,t y
respectively, and change the “Show Label” option to Caption. 

 In the View menu tab, choose Graphics 2 to open the second graphics view.  Drag 
the dividing line between the two graph windows to adjust the way in which they 
share the available space.   

 Click in the Graphics 2 pane so that it’s the active view, and then use the input bar 
to define the point     ,D y B y C .  If you don’t see this new point in the 

Graphics 2 pane, use the move graphics tool  to move the canvas until the 

point’s coordinates are in the viewing region.  You can also right click the point in 
the Algebra pane to open the object properties and check that the Graphics 2 
location is checked in the Advanced tab.  (See Figure 4.) 

 At this point, you have a rudimentary tool that you and your students can use to 
start exploring the relationship between the functions  f t  and  g t  and the 
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points  ,x y  defined by  x f t  and  y g t .  For example, ask the students 
to describe how the position of D relative to the origin will change if t increases. 

 To increase the functionality of this tool, plot the parametric curve in the Graphics 
2 pane:  Click in the Graphics 2 pane so that it’s the active view, and type 

     , , , 4,curve f t g t t x A    in the input bar.  This will graph the curve on the 
interval from 4t    to the current location of the point labeled t in the main 
Graphics pane.  As you move that point t, more or less of the parametric curve 
will be revealed. 

 Use the text tool  to create text objects that show the coordinates t, x, and y

in the main Graphics pane.  For example, to get the value of t, click where you 
want the text object to appear.  In the dialog box that appears, type “t =” and then 
choose A from the drop-down object menu.  (See Figure 7.)  A dynamic link to 
the coordinates of point A appears in the Edit line.  Inside the box indicating the 
dynamic content, change A to  x A .  (See Figure 8.)  Similarly,  x y B  and 

 y y C .

Figure 7:  Adding a dynamically linked text object 
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Figure 8:  Editing a dynamically linked text object 

 Click the small triangle at the bottom left of the slider tool  and select the  

input box tool .  Click in the main Graphics pane to create input boxes for 

the functions  x t  and  y t .  Link the caption  x t  to the function  f t  and the 

caption  y t  to the function  g t .  (See Figure 9.)  These input boxes allow 
students to think of the functions as x and y rather than  f  and g, and reinforce the 
relationships between the parametric equations and the coordinates of the points 
in the Graphics 2 view. 

Figure 9:  Adding an input box 

 Use the check box tool  (click the small triangle at the bottom left of the 

input box tool), and then click in the Graphics 2 pane to create a check box for the 
parametric curve.  Use the drop down menu in the dialog box to select the curve.  
(See Figure 10.) 
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Figure 10:  Creating a check box 

 Close the Algebra view. 

Polar Curves

You can easily adapt the parametric graphing utility to create a tool for exploring the 
relationship between the equation  r f   graphed in Cartesian coordinates and 
graphed in polar coordinates.  See an example of such a tool on GeoGebraTube, at  

http://www.geogebratube.org/student/mU2V6VQ35. 

Trig Functions and the Unit Circle

As with parametric equations, students frequently have difficulty relating the graphs of 
cosy   and siny   to the coordinates of points on the unit circle.  Using the ideas 

discussed above, it is not difficult to create a demonstration that shows the unit circle in 
one graphics view and corresponding graphs of sine or cosine in the other graphics view.  
(See Figure 11.)  You can explore an example of such a demonstration on 
GeoGebraTube, at  

http://www.geogebratube.org/student/mHxk6OqKr. 
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Conclusion:

As these examples show, the dual graphics views provided by Version 4 of GeoGebra 
make this software even more versatile than before, opening exciting new possibilities for 
the creation of applets that aid students’ visualization and understanding.  Hopefully, the 
step-by-step instructions provided in this paper will inspire you to create some of your 
own classroom demos using this marvelous software tool. 
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